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S&S® Super Stock® Ignition System Diagnostic Cable  

IMPORTANT NOTICE:

Statements in this instruction sheet preceded by the following words are of 
special significance.

WARNING

Means there is the possibility of injury to yourself or others.

CAUTION

Means there is the possibility of damage to the part or motorcycle.

NOTE

Other information of particular importance has been placed in italic type.

S&S recommends you take special notice of these items.

WARRANTY:
All S&S parts are guaranteed to the original purchaser to be free of 
manufacturing defects in materials and workmanship for a period of twelve 
(12) months from the date of purchase. Merchandise that fails to conform to 
these conditions will be repaired or replaced at S&S’s option if the parts are 
returned to us by the purchaser within the 12 month warranty period or within 
10 days thereafter. 
In the event warranty service is required, the original purchaser must call or 
write S&S immediately with the problem. Some problems can be rectified by a 
telephone call and need no further course of action. 
A part that is suspect of being defective must not be replaced by a Dealer 
without prior authorization from S&S. If it is deemed necessary for S&S to 
make an evaluation to determine whether the part was defective, a return 
authorization number must be obtained from S&S. The parts must be packaged 
properly so as to not cause further damage and be returned prepaid to S&S 
with a copy of the original invoice of purchase and a detailed letter outlining 
the nature of the problem, how the part was used and the circumstances at 
the time of failure. If after an evaluation has been made by S&S and the part 
was found to be defective, repair, replacement or refund will be granted.

ADDITIONAL WARRANTY PROVISIONS: 
(1) S&S shall have no obligation in the event an S&S part is modified by any 
other person or organization.
(2) S&S shall have no obligation if an S&S part becomes defective in whole or 
in part as a result of improper installation, improper maintenance, improper 
use, abnormal operation, or any other misuse or mistreatment of the S&S part.
(3) S&S shall not be liable for any consequential or incidental damages 
resulting from the failure of an S&S part, the breach of any warranties, the 
failure to deliver, delay in delivery, delivery in non-conforming condition, or 
for any other breach of contract or duty between S&S and a customer. 
(4) S&S parts are designed exclusively for use in Harley-Davidson® and other 
American v-twin motorcycles. S&S shall have no warranty or liability obligation 
if an S&S part is used in any other application.

SAFE INSTALLATION AND OPERATION RULES:

Before installing your new S&S part it is your responsibility to read and follow 
the installation and maintenance procedures in these instructions and 
follow the basic rules below for your personal safety.
•• Gasoline is extremely flammable and explosive under certain conditions 

and toxic when breathed. Do not smoke. Perform installation in a well 
ventilated area away from open flames or sparks. 

•• If motorcycle has been running, wait until engine and exhaust pipes 
have cooled down to avoid getting burned before performing any 
installation steps.

•• Before performing any installation steps disconnect battery to eliminate 
potential sparks and inadvertent engagement of starter while working 
on electrical components. 

•• Read instructions thoroughly and carefully so all procedures are 
completely understood before performing any installation steps. 
Contact S&S with any questions you may have if any steps are unclear or 
any abnormalities occur during installation or operation of motorcycle 
with a S&S part on it.

•• Consult an appropriate service manual for your motorcycle for correct 
disassembly and reassembly procedures for any parts that need to be 
removed to facilitate installation.

•• Use good judgment when performing installation and operating 
motorcycle. Good judgment begins with a clear head. Don’t let 
alcohol, drugs or fatigue impair your judgment. Start installation when 
you are fresh.

•• Be sure all federal, state and local laws are obeyed with the installation.
•• For optimum performance and safety and to minimize potential 

damage to carb or other components, use all mounting hardware that is 
provided and follow all installation instructions.

•• Motorcycle exhaust fumes are toxic and poisonous and must not be 
breathed. Run motorcycle in a well ventilated area where fumes can 
dissipate.

DISCLAIMER:
S&S parts are designed for high performance, closed course, racing 
applications and are intended for the very experienced rider only. The 
installation of S&S parts may void or adversely affect your factory warranty. 
In addition such installation and use may violate certain federal, state, and 
local laws, rules and ordinances as well as other laws when used on motor 
vehicles used on public highways, especially in states where pollution laws 
may apply. Always check federal, state, and local laws before modifying your 
motorcycle. It is the sole and exclusive responsibility of the user to determine 
the suitability of the product for his or her use, and the user shall assume all 
legal, personal injury risk and liability and all other obligations, duties, and 
risks associated therewith.

The words Harley®, Harley-Davidson®, H-D®, Sportster®, Evolution®, and all 
H-D part numbers and model designations are used in reference only. S&S 
Cycle is not associated with Harley-Davidson, Inc.
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INTRODUCTION

NOTE: Be sure to check the S&S® website for software upgrades.

The S&S diagnostic cable part number 55-1271 provides PC connectivity 
to the S&S Super Stock® ignition and EZFI™ module. The USB Interface 
is compatible with Windows® XP/Vista/7/8. 

The USB Interface has a switch that selects the operating mode. One 
position is used for the S&S super stock ignition and EZFI module. The 
second position is labeled “Other” and is not used at this time.

PC REQUIREMENTS:
The S&S diagnostic cable and software is compatible with PCs using 
Windows XP, Vista, 7, or 8 operating system. The PC must have a 
CDROM drive for program loading and a free USB port.

INSTALLATION OF DRIVER AND SOFTWARE
The S&S diagnostic cable is based on the FTDI FT232R chip and 
drivers that allow the unit to emulate a standard Windows RS-
232 COM port. Updated Windows drivers, installation instructions 
and troubleshooting tips are available on the FTDI website at  
www.ftdichip.com. 

The CD contains a new USB driver that simplifies the installation 
process. This installs an executable file, similar to other Windows 
programs. The Windows Found New Hardware Wizard will then detect 
the USB device when it is first connected and automatically install the 
correct driver without having to browse out to the CDROM.

DRIVER INSTALLATION
Before proceeding with installation, shut down any other applications 
that may be running. For Windows Vista, you must disable the User 
Account Control (UAC) during installation. If you are not familiar 
with the UAC, please, refer to the UAC TECH NOTE at the end of this 
instruction for details.

1.	Make sure your USB interface is not connected to your PC. 
2.	Insert the S&S Cycle Software CDROM. When the AutoPlay menu 

appears, click on “Open folder to view files” then open the “USB_
Driver” folder and double click on the “CDM20828_Setup.exe” file 
to install. Ignore any security warnings and click on Yes to continue. 
Follow the on screen instructions to complete the installation.

3.	Connect the USB Interface to the computer with the supplied USB 
cable. 

4.	The Windows Found New Hardware Wizard will appear and complete 
installation of the USB interface. Follow any on screen instructions 
that appear during installation.  

COM PORT CONFIGURATION
After completing the installation steps outlined above, you must 
configure the new COM port using Device Manager. 
1.	Windows XP: click Start, Settings, Control Panel, System, Hardware, 

and then Device Manager. Windows Vista: click Start, Control Panel, 
System and Maintenance, and then Device Manager. Windows 7/8: 
Click Start, Control Panel, System and Security, and then Device 
Manager. For more information, visit www.pcsupport.about.com.

2.	Scroll down to Ports (COM and LPT). The new USB interface will 
appear as a USB Serial Port. Click on this new port. Click on the Port 
Settings tab.

3.	Click on Advanced. In most cases the wizard will have installed your 
new USB interface as COM4 or COM5. For optimum performance, 
you should change the BM Options Latency Timer to 2 msec as 
shown in Figure 2, below.

4.	Once you have configured a COM port number for your new USB 
interface, make sure that you use this same COM port selection in 
the S&S Cycle software by using the Port Setup command from the 
Communications menu.

SOFTWARE INSTALLATION
Before proceeding with installation, shut down any other applications 
that may be running. Insert the S&S Cycle Software CDROM. When the 
AutoPlay menu appears, click on “Open folder to view files.” A folder 
will appear for each S&S Cycle software package (EZTune for S&S EZFI™ 
module and Ignition_Configuration_Utility and Operating_Statistics 
for the S&S Super Stock™ ignition). Each folder contains a setup.exe file. 
Double click on this file to install the corresponding software.

FUNCTION OF OPERATING STATISTICS
1.	Verify that the switch on the harness adapter box is switched to S&S® 

Super Stock® Ignition.
2.	Connect the black wire with alligator clip to chassis ground and the 

Packard Weather Pack connector with brown wire and alligator clip 
to the brown tach wire from the Super Stock module.

3.	Launch the operating statistics program on your computer by 
clicking on the shortcut on your desktop.

4.	The main screen appears as shown in the Figure 3, next page. 
5.	Turn the ignition key and engine run/stop switch to provide power 

to the ignition. Do not start the motorcycle.
6.	Select the correct com port you have set up on your computer.
7.	Click the read statistics button to download data from the module.
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NOTES:
•	Checking the engine rebuild box and writing it to the module will void 

your warranty.
•	Unchecked RPM break in limit will void your warranty.
•	If you wish to check the engine rebuild box, or to disable/able the break 

in RPM limit, call the S&S® Tech line for the password. The password is 
entered in the options menu.

Total hours represents the total time that the engine was running. ID 
represents the firmware identification. This field typically includes the 
manufacturer, model number, program revision and author’s initials, 
and date. Note that the date is not a manufacturing date code, just the 
date for the particular firmware release.

Elapsed time is displayed for 13 RPM bands from idle to 6999 RPM. 
Note that elapsed time data is rounded off during each engine run, so 
the sum of the elapsed time figures may not precisely match the total 
hours. The program also displays the maximum engine RPM limit (in 
seconds for better resolution) and the number of engine starts.

Clicking on the Clear Data button clears all data displayed on the 
screen. Clicking on the Print Statistics button prints a report. When you 
click on this button, a small data entry screen pops up and allows you 
to add a serial number or comment that will appear on the printout. 
You can also use the Print command from the File menu.

A user data field allows you to enter up to 32 alphanumeric characters 
in this field. User data is stored in the module EEPROM and can be 
used to represent information such as a serial number. User data is 
automatically read and displayed whenever you click on Read Statistics. 
If no valid user data has previously been written to a module, some 
garbage characters may appear in this field. You can enter new data or 
edit the existing data. When you click on the Write User Data button, 
the data is written to the module.

The elapsed time data in the various RPM bands can be displayed in the 
form of a histogram chart (Fig. 4, above) by clicking on the Histogram 
button. Color coding of the bars helps to interpret the data. The idle 
RPM band is blue, normal operating RPM bands are green and high 
RPM bands are yellow and red. The chart is automatically scaled for 
best display. You can print the chart along with a complete statistics 
report by using the Print Command from the File menu at the top of 
the chart window.

FUNCTION OF CONFIGURATION UTILITY
NOTE: The configuration utility allows the user to change to kick start or 
electric start modes.

1.	Verify that the switch on the harness adapter box is switched to S&S® 
Super Stock® Ignition.

2.	Connect the black wire with alligator clip to chassis ground and the 
Packard Weather Pack connector with brown wire and alligator clip 
to the brown tach wire from the Super Stock module.

3.	Launch the configuration utility program on your computer by 
clicking on the shortcut on your desktop.

4.	The main screen appears as shown in the Figure 5. 
5.	Turn the ignition key and engine run/stop switch to provide power 

to the ignition. Do not start the motorcycle.
6.	Select the correct com port you have set up on your computer.
7.	Select Communications, Port Setup. Choose correct com port you 

have set-up on your computer.
8.	Select Communications and download from EEPROM.
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CONFIGURATION OPTIONS
Once data has been downloaded, the configuration options dialog box 
appears.

The Kick Start Mode option is only applicable to Revision 7.0 and higher 
Super Stock® ignitions. When this option is selected, the ignition will 
immediately fire a spark when the engine is kicked over.
Cranking Revs sets the number of engine revolutions before the 
ignitions fires the first spark. Most electric-start engines will start best 
with a setting of 2. Please note that a hot engine may exhibit preignition 
and appear to start on the first revolution even if the Cranking Revs 
parameter is set to a non-zero value. The Cranking Revs slider will be 
invisible when Kick Start Mode is selected.

UPLOADING DATA TO EEPROM
Refer to the Function of Utility Configuration topic for details about 
USB Interface hookup and COM port up setup. Before uploading, make 
sure the configuration options are correct.

Upload data by using the Upload To EEPROM command on the 
Communications menu. A status message is displayed when the 
upload process has been successfully completed.

FUNCTION OF EZTUNE

The EZTune software allows the user to make precise fuel adjustments 
to the S&S EZFI system. The EZTune software includes extensive help 
files to guide you through the process of connecting and making 
adjustments to the EZFI module. You can access these help files by 
going to the Contents section of the Help menu as shown below: 

VISTA UAC TECH NOTE
An additional step must be taken when installing software on Vista 
that is not necessary on other versions of Microsoft Windows. Due to 
the User Account Control (UAC) in Windows Vista, install actions that 
require administrative privileges can be blocked. Since our software 
installations require administrative permissions, there will be problems 
in Vista if the UAC is not turned off. Before installing our software 
containing ComponentOne controls you must disable the UAC within 
Vista, restart the system, and then install the software. After you install
the software, you can enable the UAC again.

DISABLING THE UAC
The following steps explain how to disable the UAC in Vista:
1.	Be sure that you are logged into an account that has administrative 

permissions. Administrative permissions are required for the 
software installs to complete successfully.

2.	Go to the start menu and select “control panel.” This option should 
appear in the right column of the start menu.

3.	Open “User Accounts” from the control panel. This will display 
options to make changes to your user account under the heading 
“Make changes to your user account.”

4.	Click the “Turn User Account Control on or off” option.
5.	You will receive a dialog prompt asking for your permission to 

continue. Click the Continue dialog button to proceed.
6.	Now, the “Turn User Account Control On or Off” window will be 

displayed. There is a checkbox below the window text with the 
caption “Use User Account Control (UAC) to help protect your 
computer.” If this box is checked, click the box to uncheck it. Select 
the OK button.

7.	You will be prompted to restart your computer for the change to 
take effect. Restart when you are ready, then run the software 
installation. After you install, you can go back to the UAC and turn 
it on again.
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